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About this guide
This guide has been produced by the Australian Commission on 
Safety and Quality in Health Care (the Commission) to detail the 
requirements for applying the Commission’s overall branding, logo, 
corporate colours and design. 

The guide articulates the Commission’s visual style – our logo, colour 
palettes, typography, page layout and brand imagery – to help us 
achieve a professional level of consistency. The style is intended, 
subtly, to echo the Commission’s core characteristics: we are 
authoritative, methodical, structured, collaborative and transparent. 
We have strong partnerships and empower our stakeholders. Echoes 
of this can be found in the designs.

Our use of language and our visuals come together to give us our 
unique identity. We have developed a toolkit for our identity that 
consists of:  

•	 Style Guide 

•	 Design Guide 

•	 Word, InDesign and PowerPoint templates. 

The Style Guide provides information on our writing and editing 
conventions. There is also information on formatting text and tables, 
which affects their final appearance. 

The Design Guide details the elements of the Commission’s branding, 
and provides guidelines and examples of how they can be applied. 

The templates contain styles that make it easy to create a publication. 
They incorporate the main elements of the Commission brand. 

The approach detailed in this guide should be applied to all 
Commission-branded materials, all materials produced for, or on 
behalf of, the Commission, and co-branded items.
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Our visual 
identity

Visual identity seeks to convey key 
characteristics of our organisation through 
non-verbal and symbolic means.

The characteristics our visual identity seeks 
to highlight are:
•	 Authoritative
•	 Evidence based
•	 Collaborative
•	 Transparent.

Our visual identity reinforces these by 
consistently applying several design 
principles. These are outlined here.

See the Branding section for how to create 
the visual identity described here.

Evidence based
The graphic elements developed for the 
Commission are not just pretty designs. 
They are intended to have a logical 
underpinning to our work. While this logical 
basis might be only partly apparent, if at 
all, to some users, the logic exists and it is 
useful to know what it is. 

The central graphic design element for the 
Commission involves circles intersected by 
quadrants and other lines.

The Commission places strong emphasis 
on the rigour of its processes, which in turn 
underpin the authority of its publications. 
The structured approach that the 
Commission takes to its work is symbolised 
by the structured nature of the graphics.

Authoritative
This characteristic is conveyed especially 
through:

•	 Consistency of output 
Templates give a good starting point for 
documents and help create consistent 
output. Where possible, choose a 
template that works for your type of 
communication and avoid altering it

•	 Illustration and icon style 
Illustrations and icons can help readers 
understand and navigate content. In 
most cases, we avoid lighthearted or cute 
illustrations such as cartoons.

Consistency through templates

Illustration and icon style

Circles symbolise a unity, such as holistic 
health care

A quadrant emphasises the component 
parts of the whole, such as a piece of 
work or a health topic
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Logo size
Display the logo at an appropriate size 
to the communication material it is 
appearing on.

On printed documents, the minimum 
size is 10 mm high (this will make the 
logo 90.03 mm wide).

For on-screen display measured in pixels, 
the logo should be a minimum of 30 
pixels high.

Leave space around 
the logo
Include clear space around the logo to 
ensure that it is prominent and distinctive.

The minimum clear space is the same as the height of the individual large letters in the logo

The minimum size for the horizontal logo is 10 mm high

10 mm or 30 px on-screen
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We use a range of colours for publications 
and visual materials. To ensure consistency 
and colour selection, these are divided 
into three ‘palettes’: the main palette, 
the NSQHS Standards palette and the 
complementary palette.

Main palette

The main palette colours project a positive 
and vibrant tone. One or two colours from 
this palette should be sufficient for many 
applications. Avoid an overly complex and 
jarring appearance by limiting the number 
of colours in a design. Use red (485 C) 
sparingly because it is primarily used to 
indicate emergencies.

NSQHS palette

Nine colours are used to represent the 
National Safety and Quality in Health Care 
Standards. These should not be chosen for 
decorative purposes or in instances where 
there is no link to the corresponding NSQHS 
Standard(s). If your document is related 
to particular Standards, you can feature 
the colours from the NSQHS palette that 
represent those relevant Standards. Ideally, 
these colours should be used in a limited 
area of the design (e.g. a line or circle) so 
that their ‘badging’ function is established.

Complementary palette

This is an extended palette of colours that 
can be used to create colour schemes 
for publications. They have been chosen 
for adaptability and to complement other 
colours in the main and NSQHS palettes. 
They are largely intended for use by 
graphic designers. Their use in internal 
documents (built from the Word and 
PowerPoint templates) should be carefully 
considered to avoid an overly colourful 
appearance. One or two colours from the 
complementary palette should be enough 
in most applications.

Use of colour
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Use of other colours

Avoid using other colours. Introducing 
other colours or variant colour schemes 
that use some of the Commission colours 
but add others leads to an incoherent and 
compromised visual output. This would 
be less distinctive and thus less readily 
recognised as coming from the Commission.

Using tints

It is acceptable to use a tint (a mixture of 
the base colour with white) of the colours 
from the palettes in restricted situations, for 
example:
•	 As a background colour for text boxes, to 

highlight certain information or stories
•	 In graphs and tables to differentiate sets 

of data (see Graphs).

Altering colours for accessibility and readability
All Commission documents must meet government accessibility guidelines. Many of these 
guidelines relate to the readability of text. For colour, this means that text should not be 
placed on backgrounds that provide insufficient contrast.

If you wish to place text on a coloured background, ensure that there is adequate contrast 
between the text colour and the background. Text size also influences readability in 
this case. Documents published online and intended for screen viewing must meet 
the WCAG 2.0 AA guidelines. Numerous online checkers can be used to verify if text on a 
particular background will meet these guidelines (see https://contrastchecker.com and  
http://accessible-colors.com)

If text must be placed on a colour that does not provide sufficient contrast to meet 
WCAG 2.0 AA guidelines, that colour can be darkened or lightened only for that purpose. 
This alteration does not constitute an additional colour being added to the usual palettes 
and should be used only if absolutely necessary. Consider whether the text needs to be on 
a background of that particular colour, and, in general, opt for a lighter tint with darker text, 
rather than white text on a darkened background.
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Brand graphic elements
Abstract graphics have formed an important part of many 
Commission designs in the past, and they will continue to do 
so. By combining a few elements in similar ways, we can create 
graphics that are harmonious and recognisable as part of the 
Commission brand.

The two basic elements that feature in Commission graphics are 
the circle and the quadrant (quarter of a circle). These elements 
are used in a variety of ways. 

Element 1: circle Element 2: quadrant
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BODY TEXT: OPEN SANS

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
Proportional lining for numerals (for use in text)

1234567890

Typography
For practical reasons, we use two sets of 
typefaces: a design set and an office set. 
The design set is used for materials that are 
professionally designed and produced, such 
as brochures, posters and typeset reports.

The office set is used in-house for day-to-
day applications where the design set is 
not practical, such as Word documents and 
PowerPoint presentations.

Design typefaces
The main font for body text is Open Sans. 

The minimum size should be set at 9.5 pt 
and the maximum at 12.5 pt.

Use proportional lining for text and tabular 
lining for tables. Old style numerals should 
not be used. This can be formatted in 
Paragraph Style/Options > OpenType 
Features.

For text in figures, Open Sans Regular  is the 
default, with Open Sans Bold available for 
subheadings or a bold effect.
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HEADING TEXT: PROXIMA NOVA EXTRA BOLD

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

HEADING TEXT: PROXIMA NOVA BOLD

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

HEADING TEXT: PROXIMA NOVA SEMI-BOLD

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

For headings, use Proxima Nova in either 
Extra bold, Bold or Semi-bold weights. 
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MS Word
For corporate materials that are produced 
in-house, such as Word documents and 
PowerPoint presentations, Arial is the main 
font for body text.

Headings in these documents use Arial Bold.

For text in figures, use Arial Regular.

BODY TEXT: ARIAL REGULAR

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890

HEADING TEXT: ARIAL BOLD

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890
FIGURE TEXT: ARIAL REGULAR 

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz
1234567890
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Layout
The Commission uses a variety of page layouts, 
depending on the purpose and medium of 
communication.

Word documents should be laid out in a single 
column.

Audience research shows that single-
column layouts are more suited to on-
screen presentation increasingly used by the 
Commission. Double-column layouts often 
require readers to scroll vertically backwards 
and forwards on each page.

Layout aspects of the Word documents, such as 
margins, paragraph and character styles, and 
colour settings, should not be changed.

Designed documents can have variable margins 
and column numbers, widths and spacings as 
suits the design. The InDesign templates are 
a starting point for designed documents and 
contain recommended layouts. Word Template Guide 4	

1.1.1 Numbered Heading 3 
Pellentesque habitant morbi tristique senectus et netus et malesuada fames ac turpis egestas. 
Proin pharetra nonummy pede. Mauris et orci. Aenean nec lorem. 

Text formatting 
All paragraph styles have been set up to apply a specific amount of space before and after each 
type of paragraph so you should never need to include blank paragraphs as spacers or adjust 
the space settings for a paragraph or paragraph style. Also, use only a single space between 
sentences, ie full stop, single space, new sentence. To keep particular words together, 
eg numbers with their units or a person’s name, use a non-breaking space. Avoid using manual 
line breaks to force text to wrap – later editing may cause awkward breaks in reflowed text. 

Character styles 
For italicised text, eg species names or titles of books, use character style Emphasis. Do not 
simply click the ‘I’ button on the r bbon or use a text shortcut as this will apply a manual override 
to the text. Use character style StrongEmphasis for italics plus bold if required. 

Use character style Strong for bold text: do not simply click the ‘B’ button on the r bbon or 
use a text shortcut as this will apply a manual override to the text. 

More Strong text: pellentesque habitant morbi tristique senectus et netus et malesuada fames 
ac turpis egestas. Proin pharetra nonummy pede. Mauris et orci. Aenean nec lorem. 

Lists 
For more information about editing and formatting lists, see the Commission Style Guide. 

Bullet lists  

NormalBeforeBullet has reduced space after to keep it closer to the following bullet: 

• Bullet – use this for bullets other than the last in the list

– Dash – use this for a secondary bullet list

– Dash – another dash point.

• Notice the en dashes used here (not hyphens) – press Alt and dash to insert.

• Don’t leave the first or last bullet stranded on its own at the top or bottom of a page – place 
your cursor into the bullet at the bottom of the page, go to the Format menu > Paragraph > 
Line and Page Breaks and tick ‘Keep with next’ to get it to stay with the following bullet.

• BulletLast – use this for last bullet in a list to restore normal spacing before the next paragraph.

Numbered lists  
As for bullet lists, use NormalBeforeBullet before a numbered list: 

1. NumberList is not automatically numbered.

Example of text laid out in a single column in the long Word 
template

Example of text and figures laid out in the InDesign template
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Word templates
There are three Word templates. Each 
template is for a different type of 
document:

•	 Long documents 
These have a front and back cover, and 
a long imprint page. 

•	 Short documents
These are documents of 3–10 pages 
without a cover page.

External commissioned 
documents
We sometimes commission external 
bodies, such as universities and institutes, 
to produce reports, reviews and other 
publications. A guide is available to 
help these organisations format their 
publications and maintain authorship 
attribution. See D17-4815, Stakeholder 
Guide: Writing for the Commission. 

It is important that publications 
submitted by external bodies meet the 
formatting specifications outlined in the 
stakeholder guide.

Example Word template front cover

New covers can be designed in-house 
as required by program areas
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Creating your document from a 
Commission Word template

The Commission Word templates contain 
all the paragraph and character styles you 
need to create documents that conform 
with the Style Guide and the Design Guide.

Once your document is finished use the 
accessibility checker in Word to correct any 
issues. 

Getting started

To start your own document, open  
the blank template called  
D16-39305 - TEMPLATE with Cover - for 
general publications.dotx, 

D17-4816 TEMPLATE no cover - for short 
documents.dotx  

Why is it important to use styles in 
Word documents?

Styles apply correct hierarchical structure 
to your content. This allows readers to 
easily navigate through your document 
from heading to heading, whether they 
are reading a printed hard copy or using a 
screen reading device to read the document 
online. This also helps you to structure your 
document logically as you write and edit, 
and jump quickly through the document 
to a desired location. Starting with a 
template significantly cuts down the work 
required later on for layout and accessibility, 
reducing time required to complete the 
work.

To see the structure of your document:

•	 on a Mac, go to the View menu > Sidebar 
> Navigation

•	 on a PC, go to the Document Map.

To locate paragraph and character styles in 
your document:

•	 on a Mac, click Styles Pane on the taskbar 
on a PC, go to Home > Styles.

Using a Word template

Save your new document with an 
appropriate file name. Make sure 
you save it as a .docx file.
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The PowerPoint template, like the 
InDesign template, contains master pages. 
New master pages or text placeholders 
should only be created if absolutely 
required, and should be based on those 
already included in the template.

PowerPoint slides from the template

PowerPoint template
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InDesign template 

Margin and column settings in the InDesign template

Top margin: 20 mm

Outside margin: 20 mm

Inside margins: 20 mm Gutter: 6 mm

Bottom margin: 28 mm

The InDesign template provides a designer 
with a basic structure for setting up a layout 
within the Commission style.

The template is set up for a two-column 
layout with basic margins as shown in the 
example. These parameters might change 
depending on the requirements of a given 
document.

Column width: 82 mm
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Paragraph and character styles list in the InDesign template

Styles in the InDesign 
template
The InDesign template includes a large 
number of styles for controlling the 
appearance of text and other elements. 
These styles correlate directly with styles in 
the Commission Word templates, to ensure 
maximum compatibility when importing 
Word text into InDesign.

Some of the parameters of the basic styles 
are shown in the example. Completed 
InDesign documents should have no text 
without styles applied and no overrides on 
the styles.
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The main types of visual displays we use are:
•	 Tables
•	 Graphs
•	 Diagrams 
•	 Infographics
•	 Illustrations
•	 Icons
•	 Photographs.

The two most common visual elements are tables and figures. 
Graphs, diagrams and illustrations are collectively referred to as 
figures. Table and figures are usually numbered and referred to in 
the text.

Visual displays should be used to support the content. They should 
be purposeful, prominent and legible. General style principles 
include:
•	 Reducing visual clutter where possible
•	 Using colour meaningfully and consistently
•	 Keeping a standard style across similar elements (for example, 

appearance of legends, data elements, axes, typography, borders, 
colours and line styles).

Introduction
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Table title

•	 Place the title above the table (not as the first row of 
the table)

•	 Number tables consecutively within the document (for 
example, Table 1, Table 2, Table 3), or by section or chapter 
(for example, Table 2.1, Table 2.2, Table 4.1); numbering by 
section is useful because changes in one section will not affect 
numbering in other sections (this is especially important in 
long documents or those with many tables)

•	 Use a title that describes the table content, including where 
the data were collected and the period that the data cover, 
if appropriate; see the Style Guide for a advice on how to 
write titles

•	 Use sentence case (only capitalise the proper nouns and the 
first letter of the first word).

•	 Follow table numbers with a colon and set in bold, including 
the colon

•	 Use a space between the colon and the title (not a tab space), 
and do not place a full stop at the end

•	 Allow long titles to run on to the next line without a 
hanging indent

•	 For a table that continues beyond a single page, repeat 
the table number and either the descriptive part of the 
table name or continued (in italics) at the top of each 
subsequent page.

Table 2: General practitioner attendances in Australia, 2013–16

Table 3: continued

Table 3: A patient at risk of delirium is offered a set of 
interventions to prevent delirium and regular monitoring for 
changes in behaviour, cognition and physical condition

Table 1: Policies and procedures 

Table title

Table title that best 
describes table content

Long table title

Continuing table title
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City Population

Brisbane Population is 
growing rapidly 
due to:
•	 Appeal of 

warm climate
•	 International 

investment

Align all 
numbers in a 
column on the 
decimal point, 
even if the 
decimal is not 
present

Centre align 
numbers under 
the heading

Bottom align 
heading cells

Left align the 
heading and text 
in the left column

Allow width for text cells to avoid 
long, narrow blocks of text like 
this

Heading 1
Heading 2
Heading 2 Heading 3 Heading 4

Text 24 12.6 10,000

Text 24 0 10,000

Text 24 12.6 10,000

Body of the table

•	 Ensure that each data category or subcategory has its own 
column or row.

When formatting columns:
•	 Set column widths to comfortably accommodate the content
•	 Allow enough width for text cells to avoid long, narrow blocks 

of text
•	 Standardise the amount of space between columns
•	 Avoid stretching a table to fit the page width
•	 Keep column widths consistent for a series of similar tables
•	 Align all cell contents to the top of the cell, apart from column 

headings, which should be bottom aligned
•	 Left align the column heading and text in the left-hand column 

(the stub); centre align column headings for columns of 
numerical data, and left align headings for columns of text

•	 Left align columns of text.

When formatting numbers:
•	 Align all numbers in a column on the decimal point (even if 

the decimal point is not actually present)
•	 Round all numbers to the same number of significant figures 

or decimal places
•	 Centre columns of numbers under the headings – that is, 

make sure that the column of figures has roughly equal 
amounts of space on the left and the right within the column

Set column widths 
to comfortably 
accommodate the 
content

Keep the width 
consistent for a 
series of similar 
tables

Centre align 
content cells
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Definitions of acronyms used in the table or table title

The first line of table notes should define any acronyms or 
abbreviations used in the table, listed alphabetically. Use a spaced =, 
and a semicolon to separate multiple entries. There is no need for a 
full stop at the end.

EXAMPLE:

CV = coefficient of variation; SD = standard deviation

Explanation of something in the table or table title

The second line of table notes is explanations. These are indicated in 
the table by symbols. The following table shows the order in which 
symbols should be used (also see the Style Guide). Only insert a full 
stop at the end if the note is a full sentence. 

Symbol Description

* Asterisk

† Dagger

§ Section mark

# Hash

** Double asterisk

‡ Double dagger

§§ Double section mark

## Double hash

Superscript for symbols

Symbols should have a ‘superscript’ applied to them when they 
appear in the table itself (use the ‘Superscript’ character style in 
the template). The asterisk and double asterisk symbols are the 
exception to this rule because they appear superscripted by default, 
and applying superscript makes them too small.

Symbols are not superscripted in the table notes where the meaning 
of each symbol is explained.

EXAMPLE:

*	 Laboratory D did not report results corrected for recovery. Results corrected for recovery 
were calculated by the study coordinator.

†	 Preliminary results  

Other notes

The third line of table notes gives additional information about the 
whole table, given as a general note. Use the word ‘Note:’ with a 
colon. Notes should be full sentences, so start the note with a capital 
and end with a full stop. Do not put table notes in italics. For more 
than one note, use a numbered list, starting on the line underneath 
the word ‘Notes:’

EXAMPLE:

Note: Data for January to February 2017 have not been included.

OR

Notes: 

1. Data for January to February 2017 have not been included.

2. Data for March 2017 were not available.
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Sources of information

The last line of table notes gives the source(s) of information. To 
refer to the source of specific data within the table, use a superscript 
symbol and a note, as described above. For the source of the whole 
table, use the word ‘Source:’ If the source includes a numbered 
citation, insert just the author name and a superscript reference 
number; do not include the date of the reference.

EXAMPLE:

Source: Smith et al.23

Do not put a full stop at the end of the source. If multiple sources 
have been used for the table, use ‘Sources:’ and a comma between 
entries. 

All references in table notes should be cited in full in the reference 
list at the end of the document. If the table is completely original, 
leave out the source.
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Presenting graphs and data is an essential part 
of the Commission’s role. Graphs are usually the 
most effective way to show trends, patterns and 
changes in data over time, and across groups or 
categories.

Overall principles 

Simplicity and clarity 

All graphs should make complicated information 
clearer and easier to understand. The data or 
message should be the focus of your graph. 
Background or contextual information should 
use paler tints or finer lines. 

Consistency 

Recurring elements such as graph titles and 
legends should have a consistent style. Graphs 
that are to be compared with each other should 
use consistent size, axes and styling. Comparable 
data types or years should be the same colour. 

Colours

Use colour meaningfully and purposefully. For 
example, two shades of a single colour can 
indicate different years of data. For positive/
negative colour combinations, use colours from 
the main palette. Avoid using green and red 
together, because colourblind users will not be 
able to distinguish betwen them. 

It is more powerful to use a single strong colour 
to highlight the key point than to colour the 
whole figure. 

Graphs
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Acknowledging the graph source

For copyright reasons, it is usually necessary to acknowledge 
the graph source. Place the source below the graph, in the form 
‘Source: [name of source]’, as shown in the example below.

Style conventions for graphs 
Our graphs need to reflect our corporate branding where possible. 
However, design elements need to be minimised so that the content, 
not the design, is visually prominent. Graphs should always be referred 
to in the text of the document and presented with a title and a figure 
number.

Graph title

Use the following principles:

•	 Place the title above the graph, do not embed it in the graph
•	 Number figures consecutively within the document (for example, 

Figure 1, Figure 2, Figure 3), or by section or chapter (for example, 
Figure 2.1, Figure 2.2, Figure 4.1); numbering by section is useful 
because changes in one section will not affect numbering in another 
section (this is especially important in long documents or those that 
have many figures)

•	 Use a title that describes the content, including where the data were 
collected and the period that the data cover, if appropriate

•	 Use sentence case (only capitalise proper nouns and the first letter 
of the first word)

•	 Follow figure numbers with a colon and set in bold, including the 
colon

•	 Use a space before the title, and do not place a full stop at the end
•	 Allow long titles to run on to the next line without a hanging indent 
•	 For a graph that continues beyond a single page, repeat the graph 

number and either the descriptive part of the graph name or 
continued (in italics) at the top of each subsequent page.

Graph included as a numbered figure

Figure 3.2: Pathology of asthma

Source: Smith5

Graph source

Figure title Colon and space after figure number Graph title
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Style conventions for diagrams 
Our diagrams need to reflect our corporate branding where possible. 
Design elements need to be minimised so that the content, not the 
design, is visually prominent. 

If a diagram is incorporated as a figure within a document, it is 
presented in the same way as other types of figures. In some 
documents a diagram may not be referred to in the text and is not 
numbered.

Title

Use the following principles:

•	 Place the title above the diagram
•	 Number figures consecutively within the document (for example, 

Figure 1, Figure 2, Figure 3), or by section or chapter (for example, 
Figure 2.1, Figure 2.2, Figure 4.1); numbering by section is useful 
because changes in one section will not affect numbering in 
another section (this is especially important in long documents or 
those that have many figures)

•	 Use a title that describes the content, including the date, if 
appropriate.

•	 Use sentence case (only capitalise proper nouns and the first letter 
of the first word)

•	 Follow figure numbers with a colon and set in bold, including the 
colon

•	 Use a space before the title and do not place a full stop at the end
•	 Allow long titles to run on to the next line without a hanging indent. 

Acknowledging the source

For copyright reasons, it is usually necessary to acknowledge the 
diagram source, if known. You should include the source or credit 
either with the diagram. When acknowledging a diagram source, 
place the source below the diagram, in the form “Source: [name 
of source]”, as shown in the example below. If you are creating an 
original diagram no source is required.

Diagram included as a numbered figure

Figure 3.2: Pathology of asthma

Diagram source

Figure number Colon and space after figure number

Diagram/infographic title

Source: B Smith
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Style conventions for illustrations
Decorative illustrations can be useful in annual reports, on covers 
and as graphic elements in page spaces.

Scientific or technical illustrations used as figures within a 
publication should have titles as for other figures:

Illustration title

•	 Place the title as its own paragraph above the illustration 
•	 Number figures consecutively within the document (for example, 

Figure 1, Figure 2, Figure 3), or by section or chapter (for example, 
Figure 2.1, Figure 2.2, Figure 4.1); numbering by section is useful 
because changes in one section will not affect numbering in 
another section (this is especially important in long documents or 
those with many figures)

•	 Use a title that describes the content
•	 Use sentence case (only capitalise proper nouns and the first 

letter of the first word)
•	 Follow figure numbers with a colon and set in bold, including the 

colon
•	 Use a space before the title and do not place a full stop at the end
•	 Allow long titles to run on to the next line without a hanging 

indent. 

Acknowledging the source

For copyright reasons, it is usually necessary to acknowledge the 
illustrator or image source, if known. Include the source or credit 
either with the image or somewhere else in the publication, such as 
in the imprint text. Include details of cover images in the imprint text 
or as close to the inside cover as practical. 

When acknowledging an image source, place the source below the 
illustration, or in parentheses after the caption, if there is one.
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Illustration included as a numbered figure

Figure 3.2: Pathology of asthma

Illustration: B Smith

Image source

Figure number Colon and space after figure number

Illustration included without a figure number and with a caption

Pathology of asthma (illustration: B Smith, Department of Health)

Acknowledgement following caption text

Illustration title
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Photographs that are used as figures in a 
publication are numbered and have a title like 
other figures:
•	 Place the title above the photograph, not 

overlaid on the photograph
•	 Number figures consecutively (for example, 

Figure 1, Figure 2, Figure 3), or by section or 
chapter (for example, Figure 2.1, Figure 2.2, 
Figure 4.1); numbering by section is useful 
because changes in one section will not affect 
numbering in other sections

•	 Use a title that describes the content of the 
photograph

•	 Use sentence case (only capitalise proper nouns 
and the first letter of the first word)

•	 Follow figure numbers with a colon and set in 
bold, including the colon

•	 Use a space before the title and do not place a 
full stop at the end

•	 Allow long titles to run on to the next line 
without a hanging indent. 

Best-practice examples
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Acknowledging the image source

For copyright reasons, it is usually necessary to acknowledge 
the photographer or image source (below the photograph or in 
parentheses after the caption). Include the source or credit either 
with the image or somewhere else in the publication, such as on the 
imprint page. Include cover image details in the imprint text or as 
close to the inside cover as practical. 

Commissioning a photographer
Contact the Communications team if you can’t find the photograph 
you need. They can help you to find and prepare a detailed brief for 
the photographer. 

Suggested information to include in your brief or to discuss with the 
photographer before starting work includes:
•	 The Commission’s style, core ideas and values 
•	 The diversity of our audiences and the health environments we 

work in.

Specify:
•	 The purpose, setting and subject matter
•	 The visual messages that need to be portrayed
•	 That realistic and natural images are needed, not ones that are 

not obviously staged.

Also agree on: 
•	 How many images will be delivered
•	 How the images will be used (for example, A4 printed book, A0 

poster, website – this determines the size and resolution of the 
images required)

•	 Delivery or file format (for example, both high and low resolution 
jpf files, downloaded from an online link or flash drive)

•	 Licensing and copyright – the initial expectation would be that the 
Commission would either like to own the copyright, or, where the 
creator of the work does not wish to relinquish copyright, to have 
an irrevocable, royalty-free licence to republish the material in 
future publications, in print and online  
If members of the public are photographed then a Photography 
Consent Form must be completed. See the Communications 
department for more advice regarding this.

•	 Options (if any) to review the images and redirect the 
photographer if the images do not meet your stated needs.



Conventions for visual displays: Photographs� 73

Photograph included as a numbered figure

Figure 3.2: Doctor with a patient

Photograph: B Smith

Photograph source

Figure number Colon and space after figure number

Photograph included without a figure number, and with a caption

Doctor with a patient (photograph: B Smith, Department of Health)

Caption Acknowledgement following caption text

Photograph title
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Letterhead
All correspondence should use the 
Letterhead template and adhere to the 
margins and text styles in that template.

 

GPO Box 5480 Sydney NSW 2001 
T: (02) 9126 3600 |           

[Name Surname]  

[Title] 

[Organisation] 

[Address, Address] 

[CITY]   [STATE]   [POSTCODE]  

 

Dear / To [Name] (prefix and surname only)  

[Heading] 

Thank you for your letter of 23 January 2018 concerning XYZ or I am writing to you in relation to 
XYZ. I regret the delay in responding (for delays of over two months). 

All correspondence should contain an introduction clearly outlining the purpose. The body 
should address each point or issue and, where possible, reference policy or evidence. The 
conclusion should summarise the purpose and outline the resulting or necessary action, if any. 

The text is left aligned, Cambria 11 point. In the address block, use three spaces between the 
city, state and postcode. If a post office box address is provided, it should be used in preference 
to a street address. When a correspondent has written via email, and their address is not known, 
the address block in the response should include the name and e-mail address only: 

Use plain English and avoid jargon or overly technical language. Abbreviations and acronyms 
should be used sparingly and should be spelt out the first time they are used, e.g. The Royal 
Australian College of Surgeons (RACS). Always spell-out the Australian Commission on Safety 
and Quality in Health Care in the first instance, then abbreviate to ‘the Commission’. 

Use the word ‘regret’ rather than ‘sorry’ or ‘apologise’. Use the active voice rather than the 
passive voice (i.e. ‘I recommend’ not ‘it is recommended’). Don’t use ‘we’, if expressing the 
Commission’s views or policy, use ‘the Commission’. Always use a considerate, understanding 
tone. 

Use italics for the names of legislation and official publications (e.g. the Public Service Act 1999 
or the Australian Commission on Safety and Quality in Health Care Annual Report 2016–17). 
Abbreviated names used later in the document do not need to be italicised (e.g. the Public 
Service Act or the Annual Report).  

Yours sincerely 

[Sender’s name] 
[Position] 

[XX Month 20XX] 

W: www.safetyandquality.gov.au | E: mail@safetyandquality.gov.au
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Social media voice
Most social media networks are highly visual. A social media voice 
is one of the top things that disguishes the Commission from 
other organisations. The tone used should be consistent across all 
mediums. It should be reflective of how we are perceived.

Deploy a subtly different ‘tone’ and focus across different social 
media platforms. Posts should carry determined organisational 
‘voice’ for Twitter and a more authoritative and direct voice for 
LinkedIn.

Legal considerations
There may be some general legal considerations to keep in mind, 
such as copyright violations or reusing someone’s image without 
permission. Keep all bases covered. 

Social media platforms
Social media platforms include LinkedIn, Facebook, Twitter and 
YouTube/Vimeo.

Twitter is a conversational platform with high-density ‘communication 
traffic’. It is a great way for organisations to reach those they serve, as 
well as a wider circle with shared interests. It is a highly visible, public 
platform and an important avenue for industries. It is text friendly, 
although other multimedia will increase interaction.

LinkedIn is the choice platform for business-to-business marketing 
models. It can also be used as a professional content platform to 
discover and share insights. The parameters for LinkedIn are some of 
the simplest. It has little of the time and output pressure associated 
with platforms like Twitter, and the regular activities of a company 
tend to provide enough fuel for posts. It is text friendly, although 
images and video are always an asset.

YouTube/Vimeo video hosting platforms are a good way to showcase 
impact. The Commission account should include a short statement 
‘About us’, as well as the logo.

Examples of social media tiles
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